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Chapter 1:  Fundamentals 

Licensing Options enhancements 

What is it? 

You can now use the Licenses Attached to Bundle list box to select frequently used NX application 

licenses that are available with the selected license bundle. You can free the selected license, if you do not 

want to use it. To free the license from the list box, select the license and click Free Selected 
Licenses. 

Where do I find it? 

Application Gateway 

Command Finder Select License Bundles 
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Chapter 2:  Manufacturing 

Displaying cutter paths 

Display group 

 

Use the two new options in the Display group of the Home tab to manage the display of tool paths when 

you select or edit an operation.  

Display Drop-down 

 

Use the Display Tool Path    option to show a tool path relatively quickly. The Display option 

supports the options in the display group.  

Use the Replay Tool Path    option to use all of the settings in the Display Options dialog box, 

including tool and path display options, replay speed, display of feed rates, arrows, and line numbers, and 

the generation options. You open the Display Options dialog box from the Options group when you 

are creating or editing an operation.  

Coloring Drop-down 

 

You can set the tool path display colors by motion type, by operation, or by tool. 

The comparison images shown here are taken from one of the sim06_mill_5ax_cam... assemblies in your 

...\MACH\samples\nc_simulation_samples folder. The following three operations are selected in each 

image: 

   ROUGHING 

   FACE_TOP    

   CAVITY_TOP    

   CAVITY_MILL    
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 Motion Type 

Use the Motion type option to retain the display behavior of versions previous to NX 9.0.2. 

Tool path motions are displayed in the colors that you set in the Options→Edit 
Display→Path Display Colors dialog box. You can assign colors to different motions, such 

as engage, retract, rapid, and cutting moves. 

The example shows the default colors by motion type. 

 

 Tool 

Use the Tool option to display the non-rapid moves of tool paths in a different color for each 

tool.  

The example shows paths colored by tool. The first two paths are shown in a blue shade, and then 

there is a tool change. The third path, which uses a new tool, is shown in a green shade. 
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 Operation 

Use the Operation option to display the non-rapid moves of tool paths in a different color for 

each operation. 

In the example, the path for the FACE_TOP operation is rendered in a blue shade, the path for 

the CAVITY_TOP operation is a green shade, and the path for the CAVITY_MILL operation is 

a yellow shade. 

 

Customer defaults for tool and operation colors 

The Color by Tool or Operation defaults control the default colors and order for tool path display by 

tool and by operation. 

The Rapid Motion, Color and Font defaults control the font and color for rapid motions. Rapid 

motions are now red and dashed by default. 

 Tip 

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find 

Default   . 

 

Where do I find it? 

Application Manufacturing 

Prerequisite Select operations in the Operation Navigator or edit an operation. 

Ribbon bar Home tab→Display group 
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Trimming tool paths in the Tool Path Editor 

You can trim a tool path by selecting an area in the current graphics view plane. The selection tools 

include: 

● Rectangle 

● Lasso 

● Polygon 

 Tip 

To add the polygon Select by Polygon method, use the Command Finder to find Select by 

Polygon   . Right-click and choose Add to Top Border Bar. You can further customize 

the Top Border bar by dragging the icon into the Selection list. 

 

You can specify smooth connections between the truncated cutting motions. In the tool path shown, the 

walls marked (1) and (2) are colliding with the tool holder. You can trim those areas from the tool path.  

 

You can remove one area by trimming the motions 

that are inside a rectangle, as shown. 

To complete the edit, repeat the trim using a second 

inside-rectangle trim. 

  

You can achieve the same result in a single trim operation by trimming outside a selected area using the 

Lasso (shown) or Polygon selection method. 
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Smooth connections between trimmed motions 

The following figure shows the trimmed path, with the smooth connections option. 

 

Where do I find it? 

Application Manufacturing 

Prerequisite You must edit a generated tool path. 

Command Finder Edit Tool Path 

Operation Navigator [Select operation]→right-click→Tool Path→Edit 

Location in dialog box 
Edit Actions→Trim   →Trim Tool Paths dialog box→Trim 
Geometry group→Geometry = Selection in View 

Choose the trim method on the Top Border bar. 
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Cut region control for Flowcut Reference Tool 

What is it? 

You can subdivide the cut area for a Flowcut Reference Tool operation. To do this, set the Cut 
Order list to User Defined in the Flow Cut Drive Method dialog box. NX initially subdivides the cut 

area based on the steepness angle you provide. 

Region sizes 

You control the region sizes. Merge or divide the regions as required. NX  updates the cut region display 

as you make modifications. 

Example of merged regions 

   

Region 11 Region 12 Regions merged as one 

 

Region names when created: 

<operation_name> _R_1 

<operation_name> _R_2 

 

When you divide regions, NX  will append the region name with a sequential numerical value. For 

example, if you divide Operation_R_1, the resulting region names would be: 

Operation_R_1_1 

Operation_R_1_2 
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Cut regions and cutting sequence 

You control the regions to cut and their cutting sequence. Delete regions to completely avoid cutting 

certain areas. 

Cut Regions list example: 

Name Cut Order Containment Type 

Operation Regions 

FLOWCUT_REF_TOOL_R_1 1 
 

Flow 

FLOWCUT_REF_TOOL_R_1 2 
 

Flow 

FLOWCUT_REF_TOOL_R_1 3 
 

Flow 

FLOWCUT_REF_TOOL_R_1 4 
 

Flow 

FLOWCUT_REF_TOOL_R_1 5 
 

Flow 

FLOWCUT_REF_TOOL_R_1 6 
 

Flow 

FLOWCUT_REF_TOOL_R_1 7 
 

Flow 

FLOWCUT_REF_TOOL_R_1 8 
 

Flow 

FLOWCUT_REF_TOOL_R_1 9 
 

Flow 

 

Cut order labels in the graphics display correlate to the Cut Regions list. 

 

You can also do the following: 

● Control the cut pattern and other tool path parameters within each cut region. Define a region as 

steep or non-steep, and NX applies the appropriate Flowcut Drive Method settings. 

● Change the containment type for the region. 

● Reverse the flowcut region cut direction. NX will not reverse an area region. 
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Editing updates 

You can now do the following: 

● Drag regions to change the cut order. 

● Undo changes from the current editing session. 

● Save the current cutting sequence. NX saves the edits with the operation each time it generates 

the operation, and uses the saved sequence to produce the updated tool paths. 

Why should I use it? 

Managing regions can improve cutting efficiency, improve the part surface finish, and improve cutter 

wear and performance. 

Where do I find it? 

Application Manufacturing 

Prerequisite A Flowcut Reference Tool operation 

Location in dialog box Flowcut Ref Tool dialog box→Drive Method group→Method 

row→Edit     

Flow Cut Drive Method dialog box→Output group→Cut 
Order→User defined→OK 

Flowcut Ref Tool dialog box→Actions group→Generate    

→Cut Regions dialog box 
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Corner smoothing 

What is it? 

You can smooth corners in Zlevel cut patterns in Flowcut Reference Tool operations. To do this, you: 

● Set steep and non steep regions to Zlevel. 

● Select the Corner Smoothing cutting parameter. 

● Specify a Radius size to be applied to the corners. 

Previous versions of NX NX 9.0.2 

  

 

 

Why should I use it? 

When you machine hard material, or machine at high speeds, consider adding fillets to all corners. Corner 

fillets can do the following: 

● Prevent a sudden change in direction and cutter deflection which can cause excessive stress on 

the machine tool and cutter.  

● Aid in tool path generation for Nurbs output because smooth transitions are easier to blend into 

Nurbs than sharp corners. 

The Corner Smoothing option gives you better control of tool path output for finishing operations and 

improves machining efficiency. 

 

Where do I find it? 

Application Manufacturing 

Location in dialog box [Flowcut Reference Tool operation]→Cutting 
Parameters→Corners tab→Path Shape in Corners 

group→Smoothing row→All Passes 
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Automatic follow periphery pattern direction in cavity milling 

What is it? 

You can choose the Automatic pattern direction option in a Follow Periphery cut pattern. The pattern 

direction will alternate between Inward and Outward per cut level and cut region condition. NX does 

the following. 

● With an open periphery, the cutter approaches from outside the part and engages the material 

while working towards the center of the part. 

 

● With a partial or completely closed periphery, the cutter approaches from outside the part and the 

first initial entry machines a slot to reach the region start point. From there the toolpath continues 

to work its way outward. 
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● For an Outward pattern with standing bosses or features, the entry point and path to the region 

start point are optimized. 

Previous NX results NX 9.0.2 results 

  

1 = Entry point 

2 = Region start point 

 

● Pockets, voids, or existing holes are considered for the open engage portion of the tool path. 

Previous NX results NX 9.0.2 results 

 
 

 

Why should I use it? 

By using the Automatic pattern direction option, you allow NX to optimize the created cavity milling 

tool paths for maximum efficiency, tool life and performance. 

Where do I find it? 

Application Manufacturing 

Location in dialog box Cutting Parameters dialog box→Strategy tab→Cutting 

group→Pattern Direction→Automatic 
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Using a boundary with the Area Milling drive method 

Specify Trim Boundaries 

Use the Specify Trim Boundaries command to control cut areas in contouring operations that use the 

Area Milling drive method. 

Contain the cut area by one or more loops of bounding objects. Boundaries can be edges, any type of 

curves including sketch curves, or points. Boundaries are projected onto the part surfaces along the 

normal vector of the boundary plane.  

Edge as boundary   

   

Cut Region Boundary edge, trim inside Tool Path 

 

Sketch as boundary  

  

Boundary sketch, trim outside Tool Path 
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Closing gaps  

You can leave gaps between curves or edges. The gaps are automatically closed by straight lines. 

  

The arrows indicate closed gaps, boundary trim 

outside 

Tool Path 

 

Nested boundaries, no overlap  

You can define nested containment boundaries provided they indicate a clear trimming area and do not 

overlap. 

  

Outer boundary trim outside 

Inner boundary, trim inside 

Tool Path 
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Linear open boundary  

You can define open boundaries provided that the open ends project off the part. 

  

Mouse clicks at (1) and (2) define two points, off 

part, as an open boundary 

Tool Path 

 

Trim boundary options 

The trim boundary options are always available in the Contour Area operation subtype. They appear in 

the following operation subtypes after you select the Area Milling drive method : 

● Fixed Contour 

● Contour Surface Area 

Contact tool position 

When you specify the Contact tool position, NX moves the tool to contact the projected boundary in 

such a way that the entire area is cut. 

Area milling geometry with boundaries 

In the Geometry view of the Operation Navigator, you can create a MILL_AREA geometry group 

and include trim boundaries in the definition. You can then reuse the geometry area in multiple 

operations.  

NX displays this type of geometry group in the initial Geometry list only when you choose the 

Contour Area operation subtype. If you create Fixed Contour or Contour Surface Area operation 

subtypes, you must edit the drive method to Area Milling before the area mill geometry appears in the 

Geometry list. 
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Where do I find it? 

Application Manufacturing 

Prerequisite You must have a contouring operation that uses the Area Milling 

drive method. 

Location in dialog box 
Geometry group→Specify Trim Boundaries    
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Contact tool position on Area Milling boundaries 

When you specify the Contact tool position, NX moves the tool to contact the projected boundary in 

such a way that the entire area is cut. 

The part for this example has a surface that has 

both concave and convex regions. A sketched 

rounded rectangle is the boundary. 

 When projected along the tool axis, the Z-

axis in this example, the boundary 

encompasses both concave and convex 

surface areas. 

 

 

 

   

   

As seen along the tool axis, a tool path with the 

On tool position moves the tool tip strictly 

within the boundary. 

 When you use the On tool position, in steep 

areas, small concave areas are not 

completely cut, and small convex areas are 

cut outside of the boundary. This happens 

because when the tool tip is positioned over 

the boundary, the point of contact of the tool 

with the face is some distance from the 

boundary. 
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As seen along the tool axis, a path with the 

Contact tool position moves the tool tip 

beyond the boundary, or stops short of the 

boundary, depending on the nature of the 

surface slope. 

 The Contact option positions the tool tip 

such that the point of contact of the tool with 

the face lies on the boundary. This ensures 

that the tool contacts all points that lie inside 

the boundary, and does not contact points 

that lie outside of the boundary. 

 

 

 

 

Where do I find it? 

Application Manufacturing 

Prerequisite Create or edit an operation that uses the Area Milling drive method, 

and create or edit boundaries to contain the tool motion. 

Operation dialog box 
Specify Trim Boundaries    

Location in dialog box Trim Boundaries dialog box→Boundaries group→Tool 
Position list→Contact 
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Tracking points for drilling tools 

A tracking point is the internal reference point on the tool that NX uses to calculate tool paths. 

Drilling tools have two system-defined tracking 

points at the center line SYS_CL_SHOULDER 

and SYS_CL_Tip. 

 

Step drills have an additional system-defined 

tracking point at the center line of each step. 

 

For example, SYS_CL_STEP1_BOTTOM is 

located at the bottom of the first step. 

 

You can also define additional tracking points anywhere on the tool to use in your operation. 

 

Using the tracking points in the drilling operation 

You can specify separate tracking points for the non cutting and the cutting moves of a drilling operation. 

● To ensure that the tool tip clears the part, select the tracking point at the tool tip for non cutting 

moves. 

● To ensure that a position on the tool reaches a certain depth, select the tracking point that 

corresponds to that position. For example, select the shoulder of a drill, or a specific shoulder of a 

step drill. 

NX automatically changes to the correct tracking point for each type of move. For example, the drilling 

operation could use the following system-defined tracking points: 

● SYS_CL_Tip at the tool tip for all positioning and traversal moves. 

● SYS_CL_SHOULDER at the tool shoulder for the cutting moves within the drilling cycle. 

If the cycle output contains rapid moves, such as those for Break Chip or for interrupted holes, the drilling 

operation would then use: 

● SYS_CL_Tip for traversal, approach, and departure moves. 

● SYS_CL_SHOULDER for engage, cutting, and retract moves within the drilling cycle. 
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Example outputs for different drilling cycle tracking points 

 

 

 

1 SYS_CL_TIP output: 

GOTO/-25.352,89.572,-

24.403 

 

2 SYS_CL_SHOULDER output: 

GOTO/-25.352,89.572,-

22.000 

 

Where do I find it? 

Application Manufacturing 

Prerequisite Drilling tool 

Location in dialog box Define the tracking point: 

  Drilling tool dialog box→More tab→Tracking group→Tracking 
Points→Tracking Points dialog box 

Set the tracking point for non cutting positioning moves: 

  [Drilling operation dialog box]→Tool group→Cutter 
Compensation subgroup→Tracking Data list 

 Note 

To select a specific tracking point, you must customize the 

drilling operation dialog box to include the cutter 

compensation Tracking Data list. By default, NX uses the 

None option, which outputs the tool path at the tool tip 

centerline. 
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Set the tracking point for the drilling cycle: 

  [Drilling operation dialog box]→Path Settings group→Cycle 
Tracking Data list 
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Machining holes with fewer operations 

You can group through holes and blind holes to machine them together. You save on programming time 

because you do not have to program the through holes and blind holes separately. Use the Predefined 

option of the Group Features command to group features that have identical diameters, thread pitch, 

and number of steps. When it groups the features, NX ignores the values of all depth attributes, including 

tolerances, chamfers and thread lengths. 

How it works 

In NX, through holes are STEPxHOLE features and blind holes are STEPxPOCKET features, where x 

indicates the number of steps in the feature. When you group features using the Predefined option, NX: 

● Includes all STEP1HOLE and STEP1POCKET features with identical diameters in an 

FG_STEP1HOLE_STEP1POCKET feature group. 

● Includes all STEP1HOLE_THREAD and STEP1POCKET_THREAD features with identical 

diameters and thread pitch in an FG_STEP1HOLE_THREAD_STEP1POCKET_THREAD 

feature group. 

● Repeats the process for features with multiple steps. 

If additional feature groups are required for holes with different diameters, NX creates the feature groups 

and names them FG_STEP1HOLE_STEP1POCKET_1, FG_STEP1HOLE_STEP1POCKET_2 

and so on. 
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The following example shows different hole feature profiles, and how NX groups the hole features 

together. 

Features to group 

 

STEP1HOLE_1 

 

STEP2HOLE_5 

 

STEP1HOLE_2 

 

STEP2HOLE_6 

 

STEP1POCKET_3 

 

STEP2POCKET_7 

 

STEP1POCKET_4 

 

STEP2POCKET_8 

 

Features in the Machining Feature Navigator after grouping 

  WORKPIECE 

        FG_STEP1HOLE_STEP1POCKET 

        STEP1HOLE_1 

        STEP1HOLE_2 

        STEP1POCKET_3 

        STEP1POCKET_4 

        FG_STEP2HOLE_STEP2POCKET 

        STEP2HOLE_5 

        STEP2HOLE_6 

        STEP2POCKET_7 

        STEP2POCKET_8 

 

 

  



 

      NX 9.0.2 

 

   What's New in NX 9.0.2    25 

 

Sample part 

Features selected for FG_STEP1HOLE_STEP1POCKET 

 

Drilling operation for FG_STEP1HOLE_STEP1POCKET 

 

The Group Features command also has the following options: 

● None groups features whether or not the attributes are identical. 

● All groups features only if all of the attributes are identical. 

 

 

Where do I find it? 

Application Manufacturing 

Machining Feature Navigator 
  Right-click in the background→Group Features 

Grouping selected features 

  Right-click selected features→Group Features 

Location in dialog box Group by group→Identical Attributes list →Predefined 
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Enhancements to control drilling depth 

You can control drilling depth for drills and step drills in the following ways. 

● Apply a positive (1) or negative (2) bottom stock to blind holes. 

  

 

● Apply a bottom offset (1) to through holes. 

 

● Use the MODEL_DEPTH option to drill to the depth where the tool contacts the part. 

Use this method to control cutting depth for hole features where depth attributes are not relevant 

or not desired. 

● Use the Position Tool Shoulder option to control whether the tool contact point is at the tool 

tip or the tool shoulder. 

 Note 

The Position Tool Shoulder option is separate from the MODEL_DEPTH option. 
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Drilling to tool contact depth 

Use the MODEL_DEPTH option to drill to where the tool contacts the part. You control the drilling 

depth by choosing whether the tool contact point is at the tool tip or the tool shoulder. In the following 

example, (1) is a hole modeled with a flat bottom and (2) is a hole modeled with a tip angle. 

 

 

Position Tool Shoulder =    

 

Position Tool Shoulder =    

 

If you drill the hole with a tool that does not match the tip angle of the modeled hole, the operation will 

either leave material or gouge the part. 

● If you use the tool shoulder to position the tool, and the drill tip angle is less than the modeled tip 

angle, the operation gouges the part. 

● If you use the tool tip to position the tool, and the drill tip angle is greater than the modeled tip 

angle, the operation drills as deeply as it can without gouging the part. 
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The following example shows a hole feature modeled with a 122° tip. 

Hole 

   

102° drill tip 

   

122° drill tip 

   

130° drill tip 

   

Position to tool shoulder 

   

Gouges 

   

Exact match 

   

Leaves material 

Position to tool tip 

   

Leaves material 

   

Exact match 

   

Leaves material 
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Conical holes 

Use the Model Depth and Bottom Stock options to help you drill conical holes. The following 

example shows the in-process features for the operations used to rough a tapered hole. 

 

Volume to drill: 5 mm through hole with conical taper from 8 mm to 13 mm 

 

4 mm drill 

Bottom Stock = 0 

Bottom Offset = 1.0 

 

5.5 mm drill 

Bottom Stock = 0.1 

 

8 mm drill 

Bottom Stock = 0.1 

 

10 mm drill 

Bottom Stock = 1.0 
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Protecting part geometry below a through hole 

Use the Model Depth and Bottom Stock options also for through holes when you need to extend the 

depth of the in-process feature to the part geometry. 

 Note 

When you select the Model Depth feature geometry setting, and the in-process feature of a 

through hole extends to the part geometry, NX ignores the Bottom Offset cutting parameter 

setting. NX uses the Bottom Stock setting instead. 

 

The following example shows the in-process features and resulting tool path for different Machining 
Area and Bottom Stock option settings. 

 

 

Machining Area = 

FACES_CYLINDER_1 

 

Machining Area = 

MODEL_DEPTH 

1 Bottom Stock = 0 

(contact point) 

 

Machining Area = 

MODEL_DEPTH 

2 Bottom Stock = 5 

   

Bottom Offset = 2 

   

Bottom Offset = 2 

   

Bottom Offset = 2 
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Where do I find it? 

Application Manufacturing 

Location in dialog box Drilling to model depth 

  Feature Geometry dialog box→Common Parameters 

group→Machining Area list →MODEL_DEPTH 

Positioning to the tool shoulder or tool tip 

  Feature Geometry dialog box→Common Parameters 

group→Cutting Parameters subgroup→Position Tool 
Shoulder 

Adding bottom stock to blind holes 

  Feature Geometry dialog box→Common Parameters 

group→Cutting Parameters subgroup→Bottom Stock 

Adding bottom offset to through holes 

  [Drilling operation] dialog box→Cutting Parameters→Cutting 
Parameters dialog box→Strategy tab→Extend Path 

group→Bottom Offset 
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Enhancements to optimize drill sequencing 

You can optimize the drilling sequence in the following ways: 

● Machine parts with holes arranged in a grid using a zig or zig-zag pattern to minimize tool travel. 

Whenever possible, NX keeps the transition motions parallel to the axis or vector that you specify 

as the primary pattern direction. 

● Reverse the order of the listed hole or boss locations. 

● Select a hole feature and make it the start or end location of the cutting sequence. 

To see the machining order without generating the operation, preview the hole sequence. 
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Defining the hole sequence 

You can use the hole sequence defined in the HOLE_BOSS_GEOM geometry parent, or modify the 

sequence for an individual operation. 

Operation Navigator — Geometry 

     WORKPIECE 

        HOLE_BOSS_GEOMDefines the default hole sequence (1). 

            SPOT_DRILLING Uses the default sequence. 

            DRILLINGModified to use a reversed hole sequence (2). 

            COUNTERSINKINGUses the default sequence. 

 

 

Use the Reload List From Parent    sequencing option in the operation after changes in the parent 

sequence. 

 Note 

The options in the Sequence group in the Hole or Boss Geometry and Feature Geometry 

dialog boxes always display the default settings. The sequencing options are actions that NX 

execute when you click Reorder List. NX saves the resulting sequence without saving the 

settings. 
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Machining holes using a zig or zig-zag pattern 

To minimize tool travel, machine parts with holes arranged in a grid using a zig or zig-zag pattern. 

Whenever possible, NX keeps the transition motions parallel to the axis or vector that you specify as the 

primary pattern direction. 

The following example compares a zig pattern and a zig-zag pattern with the same start (1) point. The 

primary pattern direction (2) is along the X-axis. 

Zig pattern 

   

Zig-zag pattern 

   

 

The following example compares two zig-zag patterns with the same start (1) point, but different primary 

pattern directions (2). 

Primary direction along X-axis 

 

Primary direction along specified vector 
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Changing the start or end points 

To make a feature the start or end location, select it and click Move to top    or Move to Bottom 

  . 

 Caution 

Specifying an end location when using a Zig or Zig-zag pattern is not recommended. NX 

determines the appropriate end location for you. 

 

The following example compares the Hole or Boss Geometry dialog box list and preview for a hole 

sequence before and after changing the start location. 

Hole sequence with STEP1HOLE_1 as the start (1) location. 

Item Name 

 

1 

2 

3 

4 

5 

. 

. 

. 

25 

STEP1HOLE_1 

STEP1HOLE_2 

STEP1HOLE_3 

STEP1HOLE_4 

STEP1HOLE_5 

. 

. 

. 

STEP1HOLE_25 

 

Hole sequence after moving STEP1HOLE_5 to the start (1) location. 

Item Name 

 

1 

2 

3 

4 

5 

. 

. 

. 

25 

STEP1HOLE_5 

STEP1HOLE_4 

STEP1HOLE_3 

STEP1HOLE_2 

STEP1HOLE_1 

. 

. 

. 

STEP1HOLE_21 
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Where do I find it? 

Application Manufacturing 

Location in dialog box Defining the sequence for multiple operations 

  Hole or Boss Geometry dialog box 

Defining the sequence for a single operation 

  [Drilling operation] dialog box→Geometry group→Specify 
Feature Geometry→Feature Geometry dialog box 

Changing the sequence start or end location 

  Hole or Boss Geometry or Feature Geometry dialog 

box→Feature group→List subgroup→Move to top    or Move 

to Bottom    

Zig or zig-zag pattern sequence 

Hole or Boss Geometry or Feature Geometry dialog 

box→Sequence group→Optimization→Primary Direction 
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Milling hole chamfers 

 

Mill hole chamfers using the Hole Chamfer Milling operation to cut a single chamfer on multiple 

features. 

● Select hole features to chamfer, or select geometry from the graphics window. You do not need a 

modeled chamfer. 

● For modeled chamfers, select chamfer machining areas to chamfer, or select geometry from the 

graphics window. For unmodeled chamfers, select the cylindrical face to chamfer and specify the 

counter sink diameter. 

● When the angle of the cutter tip does not match the angle of the modeled chamfer: 

o The operation leaves material if the cutter angle is less than the chamfer angle. 

o The tool gouges if the cutter angle is greater than the chamfer angle. NX reports the 

gouges. 

The operation determines the in-process feature volume for the chamfer and creates a single circular cut 

around the hole diameter. 

 

Chamfer in-process feature volume 
 

Chamfer tool path 
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Tracking points 

NX drives the tracking point you select as the drive point along the top edge of the chamfer. Usually the 

tracking point is located on the cutting edge, but NX can use any tracking point that you select. 

 

 

1 Tracking point on spot drilling tool used as the drive point in the operation 

 Note 

Because the operation cuts chamfers on holes with or without a modeled chamfer, NX uses the 

selected tracking point even if the tool gouges the part or cuts air. 

 

Contact and tracking data output 

NX optionally outputs contact/tracking data at the tracking point defined on the tool diameter. Otherwise, 

NX outputs the tool path at the tool tip centerline. 

Where do I find it? 

Application Manufacturing 

Prerequisite A supported chamfering tool such as a chamfer mill, spot drill, or 

countersink tool. The tool must have the following attribute: 

● Defined tracking point. 

Command Finder Create Operation 

Location in dialog box Hole Chamfer milling operation 

  Create Operation dialog box→Type list→hole_making→Hole 

Chamfer Milling    

Selecting the tracking point 

  Hole Chamfer Milling dialog box→Path Settings group→Drive 
Point list 
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Gouge reports for authorized penetrations 

When a modeled hole is the tap drill size, you now can obtain a tool path for tapping operations without 

turning off gouge checking. 

When you generate a tapping operation with the Gouge Checking option turned on, NX does not detect 

a gouge in the threaded volume. Other gouges are still detected and reported. 

The Gouge Check command and the gouge checking options in verification and simulation no longer 

report a problem as long as: 

● The hole in the part is larger than the minor diameter of the specified thread feature. 

● The tool diameter is less than the major diameter of the thread feature. 

The threaded volume that is used for gouge checking is the in-process feature for the hole, as shown. 

 

After a gouge check of the tapping operation in the part shown, the Information window contains the 

following output: 

Operation TAPPING: No gouged motions found. 
Hybrid Gouge Checker used. 
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Where do I find it? 

Application Manufacturing 

Prerequisite Feature volumes must be defined for the operation. 

Operation Navigator Right-click operation→Gouge Check 

Right-click operation→Tool Path→Verify→Replay→Gouge 
and Collision Settings 

Operation dialog box 
Generate    

Verify→Replay→Gouge and Collision Settings 

Tool Path Editor dialog box 
Analyze Tool Path group→Gouge and Collision Check    

Simulation Control Panel 
dialog box Simulation Settings group→Simulation Settings  

 →Simulation Settings dialog box→Collision Detection 

group→Specify Collision Pairs   →Specify Collision 
Pairs dialog box→specify the part and the tool 
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Verification settings and playback enhancements 

Keyboard shortcuts 

When a playback button, for example Step, is selected, you can use keyboard keys to control the 

animation. 

   Step 
Right arrow key 

   Step Backward 
Left arrow key 

   Forward to Next Operation 
Page Up key 

   Rewind to Previous Operation 
Page Down key 

 

For continuous motion, hold the corresponding arrow key. 

 Note 

You can also use the arrow keys to move a selected slider or scroll a selected list. 

 

Tool Path Visualization settings 

The Tool Path Visualization dialog box settings are now retained throughout the NX session, with the 

following exceptions: 

● The slider value that controls the listing in the path listing window is not retained. 

● The Replay tab remains the default tab. 

 Note 

NX does not retain the settings in dialog boxes that you open from within the Tool Path 
Visualization dialog box. 
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Tool path display during playback 

The Tool Path display options include a Start to Current Motion option, to display the path from the 

start point of the operation until the current position of the tool. 

  

Start to Current Motion All 

 

Where do I find it? 

Application Manufacturing 

Prerequisite You must have at least one operation that has been generated. 

For arrow key shortcuts, click a playback button to give it the focus. 

For settings retention, reopen the Tool Path Verification dialog 

box. 

Location in dialog box Replay or 3D Dynamic tab→Tool Path list→Start to Current 
Motion 
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Boundary dialog box enhancements 

The look of the dialog boxes where you select boundary options in NX turning has changed.  

Pre-NX 9.0.2 

 

NX 9.0.2 

 

 

Turning workpiece 

The names of boundary selection dialog boxes that you access from the Turn Bnd dialog box have 

changed. To display the Turn Bnd dialog box: 

● In the Geometry view of the Operation Navigator, right-click Turning Workpiece and 

choose Edit. 

Path to boundary selection dialog 

box 

Pre-NX 9.0.2 name NX 9.0.2 name 

Click Specify Part 

Boundaries    

Part Boundary Part Boundaries 

Click Specify Blank 

Boundaries    

Select Blank Blank Boundaries 
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Turning operation 

The name of boundary selection dialog boxes that you access from a turning operation have changed. 

● Right-click any turning operation and choose Edit. 

Path to boundary selection dialog 

box 

Pre-NX 9.0.2 name NX 9.0.2 name 

Geometry group→Custom 
Part Boundary Data  

Part Boundary Part Boundaries 

 

Teach Mode operation 

The names of boundary selection dialog boxes that you access from a Profile Move type of Teach 
Mode operation have changed. 

1. Create a Teach Mode operation. 

2. In the Teach Mode dialog box, in the Sub-Operations group, click Add New Sub-

Operation   . 

3. In the Create Teachmode Subop dialog box, from the Move Type list, select Profile 
Move. 

Path to boundary selection dialog 

box 

Pre-NX 9.0.2 name NX 9.0.2 name 

Path Settings group→Drive 
Geometry list→New Drive 
Curve 

Select Drive Geometry Part Boundaries 

Start and Stop group→Start 
Position list→Check 
Curve→Start Check 
Geometry 

Select Start Check Geometry Start Check Boundary 

Start and Stop group→Start 
Position list→Check 
Curve→Stop Check 
Geometry 

Select Stop Check Geometry End Check Boundary 
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Finishing enhancements for Curve/Point drive method 

You can do the following using the Curve/Point drive method. 

● Position the tool to follow along edges of the part geometry at a specified offset using the Offset 
Left option. 

● Shift the tool contact point a distance along the curve tangent  when using a non-center cutting 

tool such as a bullnose endmill. When cutting around an axis, this is equivalent to a rotational 

shift around the axis. 

● Chamfer. 

These enhancements are primarily intended to improve the surface finish for 5-axis machining of rotary 

floors. However, the Curve/Point drive method is not used exclusively for rotary floors, and the 

enhancements may be useful for other types of applications. When the tool axis is not perpendicular to the 

cut area, you may see differences in the 3-axis tool path for the Offset Left option. See the 

Manufacturing product notes section in the Release Notes for details. 

Following edges at an offset 

NX does the following to create the tool path: 

1. Offsets the selected edges or curves along the cut area surface to create the drive curves. 

2. Checks for gouges against part or check geometry, and removes any portions of the tool path that 

gouge. If the offset value is too small to clear the geometry, NX does not create a tool path. 

 Note 

To specify an offset to the right, enter a negative value. 
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In the following example, the drive curves are selected from the feature edges. 

Part to machine 

 

Cut area and edges to offset 

 

Tool diameter = 3 mm 

Offset Left = 1.5 mm 

Drive curves 

 

Tool path 
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Shifting the contact 

The following example shows the effect of shifting the tool contact by 1.5 mm on a 3 mm diameter tool. 

Tool at default contact point 

 

Tool contact shifted 

 

 

Chamfering with Curve/Point 

Use a chamfering tool and specify negative stock to cut a chamfer. When you generate the operation NX 

displays a warning message. To continue generating the operation, click No in the message box. 

  

 

Why should I use it? 

These enhancements help improve surface finish quality. Previously, there was no way to shift the tool 

contact, and it was necessary to manually create offset curves. You no longer need to create offset curves 

to drive the tool along part features. 

 

Where do I find it? 

Application Manufacturing 

Prerequisite Curve/Point drive method 

Location in dialog box Curve/Point Drive Method dialog box→Drive Settings 

group→Offset Left and Tool Contact Shift 
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Performance enhancements for Floor Wall operations using a 3D 
IPW 

What is it? 

 

The time required to generate tool paths, or to edit an operation with the Preview option selected is now 

improved. The performance improvements depend on the complexity of the blank and 3D IPW, and are 

most noticeable when the operation uses a complex or nonrectangular blank. 

Where do I find it? 

Application Manufacturing 

Command Finder 
Floor and Wall with IPW    
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Support for MoriAPT CLSF output 

NX can now output the CLSF for single channel Mori Seiki machine tools in the MoriAPT format 

developed by Mori Seiki. DMG/Mori Seiki provides a controller-based postprocessor and simulation 

package for their CNC machines.  

When you output your machining data in the MoriAPT format, you can cut parts on Mori Seiki machines 

without having to create a postprocessor or postprocess the data in NX. 

 

The MoriAPT format is an extension to the ISO4343 APT language format. 

You must use the CLSF Output command, choose the MORIAPT format, choose a name and location 

for the file, and create the output by clicking OK or Apply. 

 Note 

Because there is no NC code file or postprocessor, you can simulate only the tool path in NX. 

 

Where do I find it? 

Application Manufacturing 

Menu Menu→Tools→Operation Navigator→Output→CLSF 

Ribbon bar [Select Operation or program group]→Home tab→Operation 

group→More→Output CLSF 

Location in dialog box CLSF Format list→MORIAPT 
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Chapter 3:  Advanced Simulation 

Importing .layup files 

What is it? 

You can now import ply definitions that are saved in the .layup format. 

Where do I find it? 

Application Advanced Simulation 

Command Finder 
Import Global Layup    

Location in dialog box File Type list→Layup files (.layup) 
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Show Critical Layer ID 

What is it? 

Use the Show Critical Layer ID command to display the ID of the critical layer for each element being 

displayed in the laminate graphical report of ply-enveloped results. The ply layer ID indicates the stacking 

order of the ply on the element. 

 Example 

In this example, the global ply IDs are 11, 12, 13, 14, 15, and 16, but, each element contains only 

three plies.  

  

Show Critical Layer ID Show Critical Ply ID 

 

For the top most elements and the bottom most elements, the critical layer is the first ply indicated 

by ID 1. For the top most elements, the first ply has a global ply ID of 14. For the bottom most 

elements, the first ply has a global ply ID of 12. 

 

The Nastran PCOMP format supports layer IDs, as opposed to the PCOMPG format, which supports 

global ply IDs. Regardless of which Nastran format you chose to solve your simulation in, you can 

display the critical ply or layer in laminate post reporting. 

Why should I use it? 

The Show Critical Layer ID command  lets you visually identify which layer is critical for each 

element of the model, independent of the ply global IDs. It is useful for graphical reports when you set the 

Ply Export Option list to Layer. 

Where do I find it? 

Application Advanced Simulation 

Prerequisite The graphical report result sets must include envelope result sets. 

Post Processing Navigator Select an enveloping result set→right-click the Post View 

node→Show Critical Layer ID 
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Chapter 4:  Shipbuilding 

Assign names to basic design objects 

What is it? 

You can assign a name and a context attribute when you create a plate system, profile system, or seam in 

the Ship Structure Basic Design application.  

● The dialog boxes for the plate system, profile system, and seam commands include a new group 

to specify the name and attribute. 

● You can also assign names to the subsystems that result from splitting a plate system or profile 

system with a seam by editing the subsystem feature in the Part Navigator. When the basic 

design is transitioned to the detail design, the subsystem names are given to the newly created 

items or design elements. 

● You can customize the naming rules for each object type in an XML file located at 

%NXSHIP_DIR%\data\ShipNamesRecipes.xml. The rules specify the field types that appear in 

the dialog box to format the name. 

For example, the following fields could be specified for a longitudinal bulkhead. 

Field Value Description 

Fixed LBH– A prefix that cannot be 

changed. 

Option P P (port) or S (starboard). The 

default value is P. 

Any – Any value specified. The 

default value is a dash. 

Index nnnn A four digit index number that 

is automatically assigned. 

 

The possible names assigned to the bulkhead could be LBH–P-0001, LBH–S-0002, or LBH–

P_x0003. 

● You can define the allowed values for a context attribute in an XML file located at 

%NXSHIP_DIR%\data\NX_ShipAttribute.xml. When you create the feature, you can select one of 

the values from a menu in the dialog box. 

For example, you could specify the context attribute value for a pillar system as Pillar, Beam, 

Stanchion, Support, Horizontal Brace, Foundation Member, Platform Member, or Post. 
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Why should I use it? 

Assign custom names and context attributes to help describe objects in the basic design. The names and 

attributes can be applied in downstream manufacturing and drafting processes. 

Where do I find it? 

Application Ship Structure Basic Design 

Command Finder 

  Hull    

  Deck    

  Transverse Bulkhead    

  Longitudinal Bulkhead    

  Stiffener System    

  Edge Reinforcement System    

  Seam    

  Pillar System    

Location in dialog box Names group specific to each command.  

For example, the Deck dialog box includes a new Deck Names 

group. 
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Profile Transition enhancements 

What is it? 

The Profile Transition command is enhanced so that you can: 

● Create transitions between edge reinforcements. The opposing end cuts must be in the same plane 

and the up directions must be parallel. A chamfer may be automatically applied when the target 

thickness is greater than the boundary thickness. 

 

● Create transitions between some misaligned profiles. You can select profiles that have end cuts in 

different planes. 

 

Why should I use it? 

These enhancements save time by automatically creating the transitions between different size edge 

reinforcements and between stiffeners that are not aligned. 
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Where do I find it? 

Application Ship Structure Detail Design 

Command Finder 
Profile Transition    

Location in dialog box Parameters group→Misaligned Transitions 
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Add knuckles to flared end cuts 

What is it? 

The End Cut command is enhanced so that you can add knuckles to flared end cuts on edge 

reinforcements and built-up profiles (1) so that they can be bent to match a boundary (2). 

 

To create a knuckled end cut: 

● The end cut must be applied to an edge reinforcement or the flange of a built-up stiffener. 

● The Limit Type must be set to Neat Trim. 

● The boundary object must be a solid body. 

● The top face of the boundary must touch the flared plate. 

● The angle between the normal of the top face of the boundary and the top face of the flared plate 

must be greater than the knuckle angle clearance. The clearance is defined in the 

KNUCKLE_ANGLE_CLEARANCE column of the parameter spreadsheet for the flared end cut 

section type. 

 

● The intersection of the top face of the boundary and the flared face must be near the intersection 

of the mold plane and the flared face. You can specify a value for the Knuckle Distance 
Tolerance in the customer defaults. 
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Why should I use it? 

Flared end cuts produce wider end plates that are welded to a selected boundary. Adding knuckles lets 

you bend the end plates to match the boundary so that they are easier to weld. 

Where do I find it? 

Application Ship Structure Detail Design 

Command Finder 
End Cut    

Location in dialog box End Treatment group→Select Flange Boundary 
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Excess Material enhancements 

What is it? 

The Excess Material command is enhanced so that you can: 

● Add excess material to multiple plates at one time 

● Use the new Fit Up option to remove material from a plate. 

 

● Use the new Linear Varying offset option to specify different offset values at the start and end 

of the selected face. 

 

● Select options to extend the side faces when you add material to plates with corner cuts or edge 

cuts. 

 

Why should I use it? 

You can use additional methods to add or remove material from the ends of plates for manufacturing. You 

can also save time by selecting faces from multiple plates at once. 
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Where do I find it? 

Application Ship Structure Manufacturing 

Prerequisite Define cutting side faces in plates using the Cutting Side Face 

command. 

Command Finder 
Excess Material    

Location in dialog box Type group→Fit Up 

Offset group→Offset Type→Linearly Varying 

Settings group→Extend Face at Start or Extend Face at End 
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Manufacturing XML Output enhancements 

What is it? 

The Manufacturing XML Output command is enhanced so that you can create and display the 

following types of markings: 

● Knuckle curves 

● Edge preparation 

● Weld bevel change 

● Edge radius 

● Stiffener alignment marks at profile cutouts 
 

The dialog box includes a new Validation group to let you display the plate markings before outputting 

XML information. The XML output also includes welding edge preparation parameters and the adjusted 

part boundary resulting from the edge preparation. 

Why should I use it? 

These enhancements let you preview and validate plate markings before outputting the information to an 

XML file. 

Where do I find it? 

Application Ship Structure Manufacturing 

Command Finder 
Manufacturing XML Output    
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Profile Sketch enhancements 

What is it? 

The Profile Sketch command includes the following enhancements: 

● Profiles with built-up section types are supported. 

● Edge reinforcements created using the Stiffener/Edge Reinforcement  command are 

supported. 

● Pillars are supported. 

● New end cut types introduced in NX 9.0 are supported. If all dimensions for an end cut type use 

default values, only the type code is shown in the drawing. 

● The marking side is shown as the main view on the drawing. 

● There are now two options to determine the pitch for an inverse bending line: frame and value. 

When the inverse bending line crosses three and more frames, the frame option is used. 

Otherwise, the value option is used.  

● The profile length in the drawing is calculated before end cuts are added. 

● Mounting angles are supported. If a stiffener has a mounting angle, a symbol is included on the 

drawing. 

● Show frame lines on the drawing if the stiffener is not bent. Dimensions to water stops are 

measured from the nearest frame line. 

● Add a second direction to the Direction Index symbol when the profile section is symmetrical in 

one direction. For example, this can apply to profiles with round, square, I type, or H type 

sections. 

● Add the correct value in the bend method column on the drawing (HEAT or PRESS). 

● Include the major drain or air hole name in the Hole column on the drawing. 

Why should I use it? 

These enhancements let you create drawings for additional types of profiles that satisfy requirements at 

your shipyard. 

Where do I find it? 

Application Drafting 

Prerequisite Open an existing assembly or workset containing stiffeners, edge 

reinforcements, or pillars. If the assembly or workset contains bent 

stiffeners, use the Inverse Bending Lines command in the Ship 

Structure Manufacturing application to create the inverse bending 

lines. 

Command Finder 
Profile Sketch    
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Specifying locations of the configuration files: 

Menu File→Utilities→Customer Defaults 

Location in dialog box Ship Drafting→Profile Sketch 
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Chapter 5:  Tooling Design 

Morphing objects using OmniCAD 

What is it? 

You can morph objects in the NX CAD environment using the following integrated OmniCAD 

commands.  

 OmniFree 
Transformer 

Use this command to morph objects using points and curves as constraints. 

 OmniMesh 
Transformer 

Use this command to morph objects using CAE Meshes, STL files, or point clouds. 

 Note 

Siemens PLM Software recommends that you use an NX facet body 

instead of a JT facet body. 
 

 OmniCopy 
Transformer 

 Use this command to copy the parameters of the transformed objects and then 

transform the objects by using the copied parameters. 

 Flow Blend 
Use this command to create constant or variable blends along complex faces that 

have small curvature. These blends are easy to manufacture and increase product 

durability and aesthetic appeal. 

 OmniSwitch 
Application 

Use this command to export NX objects that you want to transform into the 

OmniCAD software. 

 Save OCP 
File 

Use this command to export NX objects that you want to transform into the 

selected OmniCAD part file and then save the selected OmniCAD part file. 

 

 Note 

Make sure that the environment variable $OmniCAD_NX90_DIR is available in the 

\ugii\menus\custom_dirs.dat file. If this environment variable is not available, copy the 

\ugii\menus\custom_dirs.dat file to your local drive, add the environment variable 

$OmniCAD_NX90_DIR to it, and then set the environment variable UGII_CUSTOM_DIRECTORY_FILE  

to <local drive path>\custom_dirs.dat 

Where do I find it? 

Menu OmniCAD For NX→[OmniCAD commands] 
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Chapter 6:  CMM Inspection 

Programming 

General enhancements 

Overriding dimensional tolerance values defined in PMI 

Dimensional tolerance values defined in a master model may not reflect the design intent. For example, 

an acceptable angle on the part may be 89.998 degrees instead of the 90 degrees prescribed in a drawing, 

with acceptable measurement variation causing the tolerance to fail. In the Tolerance Operation dialog 

box, in the Parameters group, you can override dimensional Nominal, Upper, and Lower tolerance 

values linked to PMI. 

When you override these values, the Inherited icon    changes to a Locally defined icon    to 

indicate that the PMI value has been overridden. To recall the PMI value, click the unlock icon and 

choose Inherited from PMI. 

 

Collision avoidance progress bar 

When you run collision avoidance on inspection paths, a progress bar reports the percentage complete and 

displays each action. 

Performing analysis... 28%    PATH_CYLINDER_TOP - Find Sensor 

 

Where do I find it? 

Application CMM Inspection Programming 

Prerequisite 
● To define a dimensional tolerance operation, create an 

appropriate inspection feature. 

● To apply collision avoidance, in the Inspection Navigator, 

select one or more inspection paths. 

Command Finder 
Collision Avoidance    
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Creating plane and cylinder features from multiple faces 

What is it? 

You can create a single plane feature from multiple coplanar faces, and a single cylinder feature from 

multiple coaxial surfaces that together form a partial cylinder. When you define a point set sub-operation 

for either feature in the Inspection Path dialog box, each face gets a separate UV grid. 

 

 

 

 

The same logic applies if a tolerance is linked to multiple coplanar faces or coaxial surfaces in PMI. 

When you link to PMI, the faces or surfaces are generated as single features, and a single inspection path 

is applied. 

Why should I use it? 

When you create single plane and cylinder inspection features from multiple faces, you avoid the need to 

create multiple general surface features and individual inspection paths for those features. 

Where do I find it? 

Application CMM Inspection Programming 

Command Finder Plane, Cylinder 

Location in dialog box Creating a single plane feature from multiple coplanar faces: 

Plane Inspection Feature dialog box→Geometry 

group→Select Plane or Base Point 

Creating a single cylinder feature from multiple coaxial faces: 

Cylinder Inspection Feature dialog box→Geometry 

group→Select Cylinder or Base Point 
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Specifying user-defined events (UDEs) 

What is it? 

You can specify user-defined events (UDEs) to create dialog boxes that let you quickly insert custom 

code into your post-processed DMIS inspection programs. If you use UDEs, you do not have to write the 

same code in each program.  

When you post process your program, the manufacturing output manager (MOM): 

1. Looks for event parameters generated from UDE dialog boxes. Dialog box parameters are defined 

in a ude.cdl file. 

2. Handles these event parameters to output custom DMIS code. Event handlers are defined in a 

ude.tcl file. 

 

Why should I use it? 

A custom code event might include a command that CMM Inspection Programming does not support, or 

a complex function that otherwise takes too much work to define for every inspection program. UDEs 

make custom code reusable. 

Where do I find it? 

Application CMM Inspection Programming 

Prerequisite Define your dialog boxes in the and event handlers in the ude.cdl file 

and event handlers in the ude.tcl file, using a text editor. Restart NX 

to insert them into your inspection programs. 

Inspection Navigator Right-click the object before which you want the event to 

occur→Object→Start Events or End Events 
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Chapter 7:  Data translation 

Support for ESKD standard entities using DXF/DWG and 2D 
Exchange translators 

When you use the DXF/DWG or 2D Exchange translators, you can now export the following: 

● ESKD section lines 

● ESKD symbols 

● Limits and fits tolerance types 

● Dimensions with the text above the stub style 

● Viewing direction reference arrow 

Where do I find it? 

Command Finder Export AutoCAD DXF/DWG File 

Export 2D Exchange File 

 

CATIA V5 translator enhancement 

You can now export and import wireframe color, font, and line width between CATIA V5 and NX. 

Where do I find it? 

NX CATIA V5 Interface 

Command Finder CATIA V5 

 

NX Data Exchange CATIA V5 Interface 

Menu Siemens NX x.x→Translators→CATIA V5→CATIA V5 
Import 

Siemens NX x.x→Translators→CATIA V5→CATIA V5 
Export 
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Chapter 8:  Routing 

Convert Splines 

What is it? 

Use this command to convert pre-NX 9.0 splines in the work part to new splines. NX no longer uses the 

pre-NX 9.0 splines. 

Why should I use it? 

Each time you edit a pre-NX 9.0 spline, NX converts it to a new spline. If you use this command before 

you start working, the conversion process will not slow you down when you edit splines. 

Where do I find it? 

Application Routing  

Command Finder 
Convert Splines    
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Cut elbow placement enhancements 

What is it? 

You can now place standard and cut elbows in a single operation using either of the following methods: 

● Drag an elbow from the Reuse Library, and drop it on a corner RCP in the graphics window. 

● Use the Place Part command. 

When you use the Place Part command, you can also select an elbow that is already used in the 

assembly to place standard or cut elbows on other corners. 

To use these methods, you must set the ALLOW_CUT_ELBOW attribute to TRUE in the PTB file of the family 

of elbows. 

When you use either of the methods, NX identifies the angle at which the two segments form the 

intersection, calculates the required elbow angle, cuts the elbow if required, and places it. 

You can also place an elbow on the port of one of the two segments that form the intersection.  

 Example 

Consider the following segments with two corners. Intersection (1) which is 113°, requires a cut 

elbow of 67°. Intersection (2) which is 90°, requires a standard elbow of 90°. 

When you select a standard elbow of 90° from the Reuse Library, and place it at both the 

intersections, NX cuts the elbow to 67° while placing it at intersection (1), and places the elbow 

without cutting it at intersection (2). 

 

  

   

   

 

 

 Example 

Consider the following segments with one existing cut elbow, and two intersections on which you 

want to place elbows. 

If you use the Place Part command, you can select the existing cut elbow in the graphics window 

and use it to place elbows to complete the remaining corners. NX uses the underlying standard 

elbow part from the Reuse Library for the subsequent placement of elbows, irrespective of 

whether the corners require standard elbows or cut elbows. 
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 Note 

You can still place cut elbows using the Cut Elbow command or while using the Create Linear 

Path command with the Allow Cut Elbow    check box selected. 

 

 

Why should I use it? 

The advantage of these new methods is that you can use them to place standard as well as cut elbows. 

This is useful in the following cases: 

● Your design of segments is ready, and you have to assign elbows to multiple corners. 

● Your design already has an elbow, and you want to assign the same elbow part to other corners in 

the network. 

Where do I find it? 

Application Routing Mechanical 

Prerequisite To use these new methods, you must add the following attribute to the 

PTB file of the family of elbows or as a new column for a part in a 

PTB file. 

APPLIED  

NAME ALLOW_CUT_ELBOW 

FORMAT TRUE 

END_OF_APPLIED  
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 Tip 

● Set the ALLOW_CUT_ELBOW attribute to TRUE for 

elbows such as butt weld elbows that you intend to 

use for cut elbows. For elbows such as flanged 

elbows and threaded elbows, set the attribute to 

FALSE in the respective PTB files to ensure that they 

are not cut. The attribute and its value are case-

sensitive. 

● If you do not add this attribute to the PTB file, you 

can neither use the Place Part command nor drag 

standard elbows from the Reuse Library and drop 

them on the corner RCPs to cut and place them. 

The attribute and its value are case-sensitive. If you use 

lower case alphabets, NX behaves as if the 

ALLOW_CUT_ELBOW attribute does not exist in the PTB file. 
 

Command Finder 
Place Part    
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Assign Corner enhancement 

What is it? 

When you use this command to create a corner the attributes of the corner object are inherited by the 

corner segment and corner RCP. 

Where do I find it? 

Application Routing 

Command Finder 
Assign Corner    

 

Unify Path enhancement 

What is it? 

NX stops the Unify Path command from unifying paths if the following routing objects are a part of 

your selection: 

● Direct mount parts 

● Eccentric segment 

Now, NX stops the Unify Path command from unifying paths if the following additional routing objects 

are a part of your selection: 

● Eccentric reducer parts 

● Parts that are placed using the Instance Name Lookup command  

Where do I find it? 

Application Routing 

Prerequisite You must add the following attribute to the PTB file of the family of 

eccentric reducer parts. 

APPLIED  

NAME NX_BLOCK_UNIFY 

FORMAT TRUE 

END_OF_APPLIED  

 

The attribute and its value are case-sensitive. 

Command Finder 
Unify Path    
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Chapter 9:  Facet Body Preparation 

Create Box 

Use the Create Box command to create a bounding box around selected geometry. 

When you use the Create Box command: 

● Curves, edges, faces and faceted bodies may be selected. 

● The box is created to enclose the selected geometry. 

● The box is aligned with the WCS. 

● A clearance distance can be applied to the bounding box. 

● An associative solid body is created. 

 

When you create a box, you can control: 

● The reference CSYS orientation using the manipulator. 

 

● The color of the bounding box. 

● An offset from the body by using a clearance or by dragging the sizing handles on the box. 
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Where do I find it? 

Application Modeling, Mold Wizard, and Progressive Die Wizard 

Prerequisite A curve, edge, face, or a faceted body to select. 

Command Finder 
Create Box    
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Snap Point enhancement 

A new Point on Facet Vertex    option has been added to the snap point options, use this option to 

snap to facet vertices when creating lines, arcs, and circles based on a faceted body. 

 

The Point on Facet Vertex snap point is currently available for the following commands: 

● Point 

● Line 

● Arc/Circle 

● Lines and Arcs 

● Studio Spline 

● Fit Curve 

● Four Point Surface 

● Rapid Surfacing 

Where do I find it? 

Application Modeling 

Top Border Bar 
Point on Facet Vertex    
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Extrude Facet Body 

Use the Extrude Facet Body command to extrude an existing faceted body into a faceted solid body. 

The faceted sheet: 

● Can be extruded by distance. 

● Can be extruded to a plane. 

● Will process undercuts. 

 

 

 

Where do I find it? 

Application Modeling 

Prerequisite A faceted body 

Command Finder 
Extrude Facet Body    
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Extrude Profile 

Use the Extrude Profile command to extrude a closed profile between two planes. 

● The curve is extruded along the specified vector and trimmed by limiting planes. 

● The distance is measured from a bounding box of the input. 

● An offset value may also be applied. 

● A faceted body is created. 

 

Where do I find it? 

Application Modeling 

Command Finder 
Extrude Profile    
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Merge Disjoint Facet Bodies 

Use the Merge Disjoint Facet Bodies command to bridge the gap between two disjointed faceted 

sheet bodies and to create a single merged faceted sheet body. 

Faceted bodies may be joined using a linear or tangent option. 

 

Why should I use it? 

Faceted bodies sometimes have gaps between them that are not easily filled by additional scanning or by 

manual methods. Merge Disjoint Facet Bodies provides a convenient way to merge the bodies and 

automatically fill the gap between them. 

Where do I find it? 

Application Modeling 

Prerequisite Two faceted bodies that are not touching 

Command Finder 
Merge Disjoint Facet Bodies    
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Merge Overlapping Facet Bodies 

Use the Merge Overlapping Facet Bodies command to merge two faceted bodies into a single 

merged faceted sheet body. 

 

Why should I use it? 

Faceted bodies sometimes overlap and the area in common needs to be combined in a way that does not 

produce an overabundance of facets. Merge Overlapping Facet Bodies provides a convenient way to 

merge the bodies and re-tessellate the common areas. 

Where do I find it? 

Application Modeling 

Prerequisite Multiple faceted bodies 

Command Finder 
Merge Overlapping Facet Bodies    
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Merge Touching Facet Bodies 

Use the Merge Touching Facet Bodies command to merge two faceted sheet bodies that are touching 

at a common edge by sewing them together to create a single new faceted sheet body.  

 

Why should I use it? 

Even though two adjacent faceted sheet bodies may appear to touch at a common edge, there are often 

tiny gaps between them. Merge Touching Facet Bodies eliminates the gap and combines the bodies 

into a single faceted sheet body. 

Where do I find it? 

Application Modeling 

Prerequisite Faceted sheets 

Command Finder 
Merge Touching Facet Bodies    
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Rough Offset enhancement 

You can now use a facet sheet body as input for a Rough Offset. 

 

 

 

Where do I find it? 

Application Modeling 

Command Finder 
Rough Offset    

Location in dialog box Filter list 

Surface Generation Method→Rough Fit.  
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Chapter 10:  Active Workspace 

What is it? 

Active Workspace is a Teamcenter web client that provides Teamcenter functionality in a wide range 

of browsers, including browsers on mobile devices. The Teamcenter Active Workspace web client is 

now incorporated into NX in addition to the NX Teamcenter Navigator and provides a seamless user 

experience between Teamcenter and NX. 

By incorporating Active Workspace inside NX, a similar user experience is provided whether you are 

using Active Workspace embedded in NX or as a web client. Currently, the functionality is similar to 

what you can do in the My Teamcenter application in Teamcenter, such as view and sift through items, 

item revisions, and datasets. However you can also create workflows, show related drawings, perform fast 

and comprehensive searches, and utilize change management. This is all packaged in a new interface that 

provides robust functionality. 

 

When you access Active Workspace from NX, you can: 

● Select a part in Active Workspace and open it in NX. 

● Select a part in Active Workspace and add it as a component to the work assembly in NX. 

● Synchronize the selection of the parts between Active Workspace and NX. When you select a 

part in Active Workspace and the corresponding part is loaded in the NX session, then all of 

the occurrences of the part are selected. Similarly, if you select a part in NX and the part is visible 

in the current Active Workspace view, then it is automatically selected in Active 
Workspace. 

● Select the part in NX and open the summary page for the selected part in Active Workspace. 

In addition, from the Active Workspace web client, you can select a part and launch a new session of 

NX, which opens the selected part. 
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For this release, Teamcenter Navigator    and Active Workspace    coexist, and both are 

available from the NX Resource bar. In a future release, Active Workspace will replace Teamcenter 
Navigator as the data management tool in NX. 

 Note 

Active Workspace is available only when you are running Teamcenter 4–tier deployment 

architecture. You must setup Active Workspace so that it is integrated with NX. 

For additional details on the full capabilities of Active Workspace, see the Teamcenter Active 

Workspace Quick Start guide. 

 

Why should I use it? 

With embedded Active Workspace, you have access to a broader range of PLM data and capabilities, 

such as workflow processes, change processes, documents, and so on. 

Where do I find it? 

Application Teamcenter Integration for NX 

Resource bar Active Workspace 
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